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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview 

"Steam cracking" is a petrochemical process in which long-chain hydrocarbons 
(e.g. naphtha = petroleum) are converted into short-chain hydrocarbons by thermal 
cracking in the presence of steam. The main products produced are hydrogen, 
methane, ethylene and propene, butylene, pyrolysis gasoline and a tar-like residue 
(ECR: ethylene cracker residue). The raw materials obtained in this way are mainly 
used for the production of plastics, paints, solvents or pesticides.  

The cracker plant is one of the most complicated plants in the petrochemical 
industry and can be divided into two large sub-processes: the cracker furnace itself 
and a downstream, multi-stage separation process consisting of distillation 
columns, steam separators and similar subsystems. The cracking furnace is a so-
called tube reactor. The educt passes through the furnace simultaneously in many 
separate tube bundles with a small inner diameter of approx. 10 cm, so-called 
passes. 

 

The Unit Template "Steam Cracker" contains prefabricated, standardized and 
ready-wired Equipment Modules and Control Module Types for the cracking 
furnace. Starting from this sample solution, numerous instances with different 
parameterizations can be generated and integrated into many automation solutions 
in an adapted form. The PCS 7 project is configured to be hardware-independent 
and can be flexibly incorporated into existing projects. 

Advantages 

Its utilization offers the following advantages:  

• A reduction of the knowledge necessary to develop applications 

• A decrease in the configuration effort 

• More flexible setup and adaptation due to equipment modules  

• Standardized structures 
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1.2 Principle of operation 

In cracking, an educt containing long-chain hydrocarbon molecules, e.g. naphtha, 
is preheated and then mixed with steam. The water-naphtha mixture is heated to a 
temperature of approx. 840°C in a coil of pipes. The long-chain molecules are 
thermally split within fractions of a second and a mixture of many substances with 
short-chain molecules is formed. The addition of water prevents the fission 
products from splitting further into even shorter-chain hydrocarbons. 

The yield is of fundamental importance for the economic operation of a cracker. 
The main focus is on the yield of the two main products ethylene (C2H4) and 
propylene (C3H6).  

In addition to the yield, the current intensity of the splitting process ("severity") 
plays a decisive role in the economic operation of a cracker. The severity quantifies 
the ratio of certain concentrations at the cracker outlet, for example the 
concentration of methane to propylene. 

The material conversion of the long-chain hydrocarbons to the desired main 
products and the severity depend on many influencing factors and are therefore 
controlled by a corresponding multi-variable controller. 

The required measurements of the yield or the intensity of the splitting process 
cannot be determined directly at the exit of the splitting furnace, but only summary 
and with a long delay at the downstream subsystems. To be able to respond to 
changes as quickly as possible directly in the cracker, the current value must be 
determined via a model-based soft sensor. 

The tubes inside the furnace through which the educt/water vapor mixture flows 
consist of a special alloy which ensures that the best possible heat transfer to the 
material mixture is possible. In the long run (over several weeks) deposits on the 
pipes are increasing. This worsens the heat transfer between the outside and 
inside of the tubes. The current strength of the coking is also not measurable and 
must be estimated e.g. by a model. The yield of the cracker drops, depending on 
the degree of coking. If coking is too high, it is more profitable to switch off the 
system for cleaning. Along the pipes (length 60-80 meters) the degree of coking 
can vary considerably. Precise temperature measurement on the many pipes as 
basis for conventional control is very difficult to achieve. 

A particular challenge is therefore to minimize coking. On the other hand, the 
current extent of coking must be reliably determined so that, if necessary, dates for 
cleaning can be planned. 

In order to counteract the different coking of the pipes, an approach for a so-called 
"Pass Balancing" is required. It must be possible to optimize the flow of the 
reactants supplied and the temperature at the coil outlet ("coil outlet temperature") 
for each pass individually using a control concept. At the same time, the total 
throughput of converted educt must be maintained as well as possible. 
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Delimitation 

Typical designs for steam crackers have two combustion chambers at the lower 
end with typically 2 to 4 passes per combustion chamber. In this automation 
solution, all coils heated by a combustion chamber are represented by one coil. 

In addition, only one of the two combustion chambers is implemented, the second 
half of the furnace can be created by duplicating the first half. 

The thermal behavior of the entire furnace, with the heat capacities of the steel 
masses, is not taken into account, nor is the spatial expansion of the furnace 
chamber. 

The process engineering process within the cracker furnace is only very simplified 
and simulated linearly in SIMIT respectively in SIMATIC PCS 7. 

The necessary soft sensor for calculating the relevant measured variables has to 
simulate the dynamics of the gas phase reaction in the pipe coils as a realistic 
system with spatially distributed parameters. This requires a model of the system 
with coupled differential-algebraic equations. The number of equations in the 
"Steam Cracker" model is typically more than 50,000 equations and therefore 
cannot be simulated in SIMATIC PCS 7. For applications in real plants, the model-
based soft sensor for each cracking furnace is implemented in PSE's simulation 
software gPROMS and connected to SIMATIC PCS 7 via OPC UA. 

The Unit Template "Steam Cracker" contains a prefabricated solution for the 
cracker oven. The downstream, multi-stage separation process is not considered, 
since a Unit Template "distillation columns" \7\ is already available for the 
separation process. 

The fail-safe implementation as well as a detailed description of the function and 
structure of the GARC is described in the PCS 7 Unit Template – Gas Fired Steam 
Boiler \9\. 

Required knowledge 

Fundamental knowledge of the following specialist fields is a prerequisite: 

• Engineering with SIMATIC PCS 7 and APL 

• Knowledge of control technology 

• Basic knowledge of process technology 

• An understanding of the Equipment Modules concept 

• Basic knowledge with SIMIT 
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1.3 Components used 

The following hardware and software components were used to create this 
application example:  

Component Note 

SIMATIC PCS 7 ES/OS 
IPC547G W7 

For the PCS 7 V9.0 SP1 example project 

SIMATIC PCS 7 V9.0 
SP1 

Part of SIMATIC PCS 7 ES/OS IPC547G W7 

APL library V9.0 SP1 Part of SIMATIC PCS 7 V9.0 SP1 

CFC V9.0 SP2 License is a component of SIMATIC PCS 7 V9.0 SP1, the 
update can be obtained from the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109756832 

Software templates Equipment Modules for SIMATIC PCS 7 using the example of 
the Chemical Industry 
https://support.industry.siemens.com/cs/ww/en/view/53843373 

S7 PLCSIM (optional) Not a part of SIMATIC PCS°7 V9.0 SP1, additional licenses 
required 

SIMIT V10.0 (optional) Not a part of SIMATIC PCS°7 V9.0 SP1, additional licenses 
required 

Virtual Controller V10.0 
(optional) 

Not a part of SIMATIC PCS°7 V9.0 SP1, additional licenses 
required 

 

Note If the hardware is different, observe the minimum requirements for installing the 
software components. The minimum requirements can be found in the PCS 7 
Readme under the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109750097. 

 

This application example consists of the following components:  

Component Note 

109769355_Steamcracker_DOC_PCS7_V90SP1_de.pdf This document 

109769355_Steamcracker_PROJ_PCS7_V90SP1.zip PCS 7 V9.0 SP1 example 
project 

109769355_Steamcracker_SIMIT_PCS7_V10.simarc SIMIT V10.0 example 
project for PLCSIM 

109769355_Steamcracker_SIMIT_VC_V10.simarc SIMIT V10.0 example 
project for Virtual Controller 

https://support.industry.siemens.com/cs/ww/en/view/109756832
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/109750097
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2 Preparation and commissioning 

2.1 Choice of simulation type 

The Unit Template has several options for simulating the steam cracking process, 
so that the simulation type can be selected for the demonstration of the Unit 
Template depending on the available license. The following simulation choices are 
available: 

• PCS 7 with PLCSIM (process simulation in CFC) 

• SIMIT with PLCSIM (process simulation in SIMIT) 

• SIMIT with Virtual Controller (process simulation in SIMIT) 

Depending on the simulation type, different steps must be performed to 
commission the Unit Template. The following table shows the necessary chapters 
for commissioning the Unit Template. 

Chapter PCS 7 with 
PLCSIM 

SIMIT with 
PLCSIM 

SIMIT with 
Virtual 

Controller 

Preparation in PCS 7 X X X 

Preparation in SIMIT with PLCSIM  X  

Preparation in SIMIT with Virtual Controller   X 

Commissioning in PCS 7 X X  

Commissioning in Virtual Controller   X 

Activate the simulation with SIMIT  X X 

 

2.2 Preparation in PCS 7 

The following instructions describe how to prepare the application example to be 
able to simulate the controller later. If a real controller is available, you must 
configure the hardware components in the HW configuration. 

1. Copy the file "109769355_Steamcracker_PROJ_PCS7_V90SP1.zip" into any 
folder on the configuration computer and then open the SIMATIC manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109769355_Steamcracker_PROJ_PCS7_V90SP1.zip". Then click "Open" to 
confirm. 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. Click the "OK" button in the "Retrieve" dialog and then click "Yes" in the dialog 
to open the project.  

5. Right-click on "UT_Cracker_OS > OS01 > WinCC Appl. > OS" and click on the 
menu command "Open object". 

6. Confirm the "Configured server is not available" dialog with "OK". 

7. Open the properties of your computer in WinCC Explorer and click on the 
button "Use Local Computer Name" in the opened properties dialog. 
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8. Confirm the "Change computer name" message with "OK". 

9. In WinCC Explorer, click "File > Exit" and in the subsequent dialog select 
"Terminate WinCC Explorer and close project". 

10. Then confirm with "OK". 

2.3 Preparation in SIMIT with PLCSIM 

The following instructions describe the necessary preparation in SIMIT if the 
software PLCSIM is used for the emulation of AS: 

1. Copy the file "109769355_Steamcracker_SIMIT_PCS7_V10.simarc" into any 
folder on the configuration computer and then open SIMIT. 

2. Select the menu item "Retrieve project". 

3. Select the archived project in the "Archive name" field and click "Open" to 
confirm the dialog. 

4. In the field "destination folder", select the path where you want to retrieve the 
SIMIT project and click "Open" to confirm the dialog. 

5. Now click on the "Retrieve" button. 

6. Change from the "Portal view" to the "Project view" 

7. Start the simulation "Simulation > Start". 
In simulation mode, the color scheme from SIMIT changes to orange. 
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2.4 Preparation in SIMIT with Virtual Controller 

The following instructions describe the necessary preparation in SIMIT if the 
software Virtual Controller is used for the emulation of AS: 

Preparation at the PCS 7 project 

1. Right-click on "UT_Cracker_OS > OS01 > WinCC Appl. > OS" and click on the 
menu command "Compile". 

2. Click on "Next". 

3. Click on the "Connections" button and select "Named Connections." 

 

4. Confirm the setting with "OK". 

5. Compile the program with clicking on "Finish" and "Compile". 

 

Preparation of the PC Station 

NOTE Communication with the Virtual Controller is network-based. For this reason, an 
additional IP address must be configured on the computer on which the VC is 
started. 

 

1. Open the network settings of your engineering station. 
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2. Enter an additional IP address for the VC in the properties of the "TCP / IPv4" 
interface. The IP address is the same as the configured AS in HW 
configuration (192.168.0.1). 

 

 

Starting the simulation (S7 PLCSIM) 

1. Copy the file "109769355_Steamcracker_SIMIT_VC_V10.simarc" into any 
folder on the configuration computer and then open SIMIT. 

2. Select the menu item "Retrieve project". 

3. Select the archived project in the "Archive name" field and click "Open" to 
confirm the dialog. 

4. In the field "destination folder", select the path where you want to retrieve the 
SIMIT project and click "Open" to confirm the dialog. 

5. Now click on the "Retrieve" button. 

6. Change from the "Portal view" to the "Project view" 

7. Start the simulation "Simulation > Start". 
In simulation mode, the color scheme from SIMIT changes to orange. 
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8. When the simulation is started in SIMIT, the virtual controller is also started. 

Frei verwendbarFrei verwendbarFrei verwendbar

 

 

2.5 Commissioning in PCS 7 

The following instructions show how to initialize the Unit Template with PLCSIM. 
The project contains an SFC in which all important settings are configured so that 
the system reaches the operating point. 

For commissioning it is assumed that the SIMATIC manager has already been 
opened and the Unit Template is selected in the component view. 

Starting the simulation (S7 PLCSIM) 

To start the simulation, proceed as follows: 

1. Select "Options > Simulate Modules" from the menu. 
The "S7-PLCSIM" dialog window opens. 

2. Select the "Open PLC" option in the "File" dialog. 

3. Select the file "Steamcracker.plc" from the path 
<project path>\UT_Cacker_MP\UT_C_MP\Steamcracker.plc">. 
Simulation is started. 

4. In the selection list, change "PLCSIM(MPI)" to "PLCSIM(TCP/IP)". 

 

Activate OS runtime 

Proceed as follows to activate the OS Runtime: 

1. Right-click on "UT_Cracker_OS > OS01 > WinCC Appl. > OS" and click on the 
menu command "Open Object". 

2. Open the "Tag Management" by double-clicking it. 

3. In "WinCC Configuration Studio", open "Tag Management > SIMATIC S7 
Protocol Suite > TCP/IP" and select "System parameters" in the context menu. 

4. In the register "Unit" check the set "Logical device name". When using the "S7-
PLCSIM" program, "PLCSIM.TCPIP.1" is selected as the device name.  
A restart is required after a device name change. 

Note If the OS cannot establish a connection to the AS (gray block symbols), select 
the logical device name "CP_H1_1:" and restart the OS Runtime. 
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5. Select "File > Activate" in the WinCC Explorer menu. 

6. Enter in the dialog "System Login" as "Login" the user "Unit" and as password 
"Template" and confirm with "OK". 

7. Select "Ethylene" in the picture area 

 

 

Note The steam cracker is already in the production process because the AS program 
execution (PLCSIM) has already been started. 

 

2.6 Commissioning in Virtual Controller 

The following instructions show how to initialize the Unit Template with PLCSIM. 
The project contains an SFC in which all important settings are configured so that 
the system reaches the operating point. 

For commissioning it is assumed that the SIMATIC manager has already been 
opened and the Unit Template is selected in the component view. 

Download the software 

To start the simulation, proceed as follows: 

1. Right-click on "UT_Cracker_OS> AS01" and click on the menu command 
"Open Object". 
The HW Config opens. 

2. Click on "PLC > Download". 

3. Select the option "Download in STOP mode" and confirm your entry with "OK". 

4. Confirm the selection of the CPU and the address with "OK". 

5. Open any CFC. 

6. Click on "CPU > Download". 

7. Select the option "Entire program" and confirm your entry with "OK". 
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Activate OS runtime 

Proceed as follows to activate the OS Runtime: 

1. Right-click on "UT_Cracker_OS > OS01 > WinCC Appl. > OS" and click on the 
menu command "Open Object". 

2. Select "File > Activate" in the WinCC Explorer menu. 

3. Enter in the dialog "System Login" as "Login" the user "Unit" and as password 
"Template" and confirm with "OK". 

4. Select "Ethylene" in the picture area 

 

 

Note The steam cracker is already in the production process because the AS program 
execution (PLCSIM) has already been started. 
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2.7 Activate the simulation with SIMIT 

The following instructions describe how to start the application example with the 
SIMIT simulation: 

1. Switch to the WinCC runtime. 

2. Click on the block symbol of the "SIMIT_PCS7" block. 
The corresponding faceplate will be opened. 

 

3. Click Command on the faceplate and select "SIMIT". Confirm your entry by 
clicking on "OK". 

 

The process values are now simulated in SIMIT. 



3 Controlling the application 

 

UT Steamcracker 
Entry ID: 109769355,    V1.0,    10/2019   17 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

3 Controlling the application 

3.1 Components of process visualization 

The figure below shows the process picture of the application example: 

1

3

2

4

5

 

1. Inflow ("Feed") 

2. Burner control ("Heating") 

3. MPC 

4. Furnace chamber ("Cracker") 

5. Soft sensor 

1. Feed 

The feed material educt and water are supplied in a defined mixing ratio via the 
inflow. The flow rate of the reactant is specified by the MPC via a setpoint and 
controlled by the flow controller via a proportional valve. After preheating of the 
reactant in the upper part of the cracking furnace, water vapor is mixed in a defined 
ratio, which is also controlled via a subordinate PID control loop with continuous 
valve. The ratio of water vapor to educt is specified by the MPC in a narrowly 
defined range (ratio from 0.30 to 0.35). 

2. Burner control (Heating) 

A prerequisite for the chemical reactions is the correct temperature of the 
educt/water vapor mixture. In order to achieve a specified temperature inside the 
pass, the amount of gas and air in the burner is controlled by means of proportional 
valves. The burner is controlled via burner load specified by the MPC and the "Gas 
Air Ratio Controller (GARC)". The GARC calculates the required amount of gas 
and combustion air from the burner load, which is supplied in the correct 
stoichiometric ratio to the fuel. This ensures that a defined minimum excess of air is 
maintained in both stationary and dynamic operating conditions in order to 
guarantee a safe system condition. The GARC is part of the PCS 7 Unit Template 
Gas Fired Steam Boiler \9\. 
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3. MPC 

The aim of the control is, on the one hand, to keep the quantity of ethylene and 
propylene produced as high as possible and, at the same time, to achieve a high 
conversion rate of the starting materials in order to keep scrap to a minimum. 
Production depends on many influencing factors and is therefore controlled by a 
corresponding multi-variable controller. The control variables selected are the 
throughput of the desired product and the conversion rate of the ethane added. In 
order to guarantee a safe system condition, the outlet temperature of the tube 
bundle (COT = Coil Outlet Temperature) and the tube wall temperature (TMT = 
Tube Metal Temperature) are kept within the tolerance band by the MPC as 
additional controlled variables. As soon as one of the two temperatures threatens 
to leave the tolerance range, they are considered by the MPC with high priority. 

4. Furnace chamber ("Cracker") 

The chemical reactions take place in the furnace chamber. The long-chain 
molecules are thermally split at the high temperature in fractions of a second, 
resulting in a mixture of many substances with shorter-chain molecules. 

To heat the mixture, it passes through the furnace chamber of the cracking furnace 
in many separate tube bundles with a small inner diameter of approx. 10 cm, so-
called passes. Typically, two to four coils (passes) pass through the furnace. The 
furnace in turn normally has two furnace chambers (Cells) at the lower end. In the 
furnace chamber, the coils separate into many smaller tubes with a diameter of 
approx. 10 cm, the coils. Here, the water vapor-educt mixture is split into short-
chain molecules. The cracking furnace is a tube reactor. 

5. Soft sensor 

The ethane conversion rate and the ethylene yield are of decisive importance for 
process control. However, the material and reaction properties cannot be 
determined directly at the exit of the cracking furnace, but only with great delay at 
the downstream subsystems. An essential component of the Unit Template is 
therefore a soft sensor for calculating certain parameters including the ethane 
conversion rate and the ethylene yield, which are of decisive importance for 
process control. The soft sensor calculates the internal states of the steam cracker 
by simulating a dynamic process model and the input variables into the system in 
parallel. The subset of the system states corresponding to metrologically recorded 
variables are compared with the corresponding measured values of the real 
cracking process and used for online correction of the estimated states. 
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3.2 Scenarios 

3.2.1 Overview 

All components of the steam cracker can be operated and monitored via the 
process picture. In addition, the plant operator receives information (KPIs: Key 
Performance Indicators) on the current process status. 

Note Please note that it takes about 3 minutes after the program start of PLCSIM until 
the steam cracker is at the operating point. During the running production 
operation, all controllers are enabled. You can recognize this state in the SFC, 
for example, if it has successfully processed all process steps. 

The following two scenarios refer to the handling of the Unit Template "Steam 
Cracker": 

• Compensation of coking 

• Leaving the tolerance band for TMT 

3.2.2 Scenario A - Compensation of coking 

Description 

In this scenario, the steam cracking process is simulated. A mixture of water vapor 
and educt is heated to temperatures of approx. 840°C within a pipe coil in the 
cracking furnace. The long-chain molecules are thermally split at the temperature 
in fractions of a second and a mixture of many substances with short-chain 
molecules is formed. In the long run, coking on the pipes are increasingly caused 
by the chemical reaction in the furnace. This worsens the heat transfer between the 
outside and inside of the tubes. In this scenario, the MPC automatically 
compensates for coking. 

Procedure 

1. Open the process picture of the steam cracker. 

 

 

2. Left click the "On/Off" button in the "Tag name" field to display the block 
names. 
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3. Click on the block symbol of the "Reset_CokeLevel" block. 
The corresponding faceplate will be opened. 

 

4. Click Command on the faceplate and select "On". Confirm your entry by 
clicking on "OK". 

 

5. Click Command on the faceplate and select "Off". Confirm your entry by 
clicking on "OK". 
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6. Click on the button "trend system" and select the trend display "UseCase1". 

 

7. Open the trend display by clicking on "Display". 

 

8. Wait approx. 12 minutes and click on the "Start/Stop" icon to evaluate the 
control result. 
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Evaluation 

The following figure shows the trend for the steam cracking process. 

Simulation period
of a month

 

Due to the deposits on the pipes (blue line), the heat transfer between the outside 
and inside of the pipes deteriorates, this is shown in the trend over the blue line 
(thickness of the deposits) and green line (increase of the deposits). The 
deteriorate heat transfer leads to a reduction in the quantity of ethylene produced 
(red line) and conversion rate of the ethane supplied (black line). These deviations 
from the corresponding setpoint are compensated by the MPC by increasing the 
amount of energy supplied. As the result, the increase of the deposits over the 
operating period increases. During the simulation period of one month, the MPC 
can compensate for the disturbance caused by the coking process. With increasing 
duration, the control deviation becomes larger and larger until cleaning becomes 
necessary. 

 

3.2.3 Scenario B - Leaving the tolerance band for TMT 

Description 

The aim of the control is, on the one hand, to keep the quantity of ethylene and 
propylene produced as high as possible and, at the same time, to achieve a high 
conversion rate of the starting materials. However, certain limits must not be 
exceeded in order to guarantee a safe system condition. In this scenario, a 
disturbance is added to the temperature TMT ("Tube Metal Temperature") so that 
the temperature leaves the tolerance band. The configuration of the MPC takes this 
process variable into account with high priority in order to ensure continued safe 
operation. 
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Procedure 

1. Click on the block symbol of the "Reset_CokeLevel" block. 
The corresponding faceplate will be opened. 

 

2. Click Command on the faceplate and select "On". Confirm your entry by 
clicking on "OK". 
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3. Click on the block symbol of the "ActDisTMT" block. 
The corresponding faceplate will be opened. 

 

4. Click Command on the faceplate and select "On". Confirm your entry by 
clicking on "OK". 
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5. Click on the button "trend system" and select the trend display "UseCase2". 

 

6. Open the trend display by clicking on "Display". 

 

7. Wait about 3 minutes and click on the "Start/Stop" symbol to evaluate the 
control result. 
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Evaluation 

The figure shows the trend curves of the multi-variable controller when the 
disturbance is added to the temperature TMT. 

 

The temperatures COT ("Coil Outlet Temperature", green line) and TMT ("Tube 
Metal Temperature", blue line) must be kept within the tolerance range for safe 
operation of the system. Due to the limited number of degrees of freedom, the 
MPC was designed to control the amount of ethylene produced (red line) and the 
conversion rate of the starting materials (black line). The temperatures COT and 
TMT are kept within the respective tolerance band by the MPC. As soon as one of 
the two temperatures threatens to leave the tolerance range, these are considered 
by the MPC with high priority. Due to the setpoint change for the tube metal 
temperature, the process value leaves the tolerance band. This leads to the MPC 
giving high priority to bringing the temperature back into the tolerance band, but 
also to a significant reduction in the amount of ethylene produced and the 
conversion rate of ethane. Due to the limited number of degrees of freedom and 
the limitation of the tube metal temperature, the MPC cannot reach the target 
values for the quantity produced and the conversion rate. The MPC controls the 
system so that the tube metal temperature is maintained at the upper end of the 
tolerance band and the quantity produced and the conversion rate are as high as 
possible. 
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4 Integration of the Unit Template 

4.1 Preparation 

1. Copy the file "109769355_Steamcracker_PROJ_PCS7V90SP1.zip" to the 
configuration computer and then open the SIMATIC manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109769355_Steamcracker_PROJ_PCS7_V90SP1.zip". Then click "Open" to 
confirm. 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. Click the "OK" button in the "Retrieve" dialog and then click "Yes" in the dialog 
to open the project. 

5. Switch to the "Plant view". 

6. In parallel, open the project in which the Unit Template is to be integrated. 

 

4.2 Copying templates 

Note If you have already worked with CMTs in your existing project, then check for 
equality before the following steps, as this can lead to errors in your existing 
project or the Unit Template to be integrated. 

1. Go to the plant view. 

2. Copy the "CMT" folder containing the CMTs from the master data library and 
paste it into the target project. 

 

 

3. Copy the enumerations from the master data library and paste them into the 
target project. 
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4.3 Copying a plant section 

1. Copy the hierarchy folder "Ethylene" from the AS project of the Unit Template 
into the plant hierarchy of the target project. 

 

 

2. Copy the process picture "Cracker" from the OS project of the Unit Template 
also into the plant hierarchy of the target project. 

 

 

Note When copying the process picture, make sure that you copy the picture to the 
hierarchy level of the target project that is created as the OS area. 

 

3. If you also want to use the customer-specific units in your project, copy the file 
"APLCustomerUnits.xml" from the directory "<Project 
path>\UT_Cracker_MP\UT_C_OS\wincproj\OS\GraCS\" into the GraCS folder 
of the target project. 
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4.4 Customizing the OS project 

In order to be able to change the colors in the process picture of the steam cracker 
easily in a central place, a central color palette was created in the OS project of the 
Unit Template. To ensure that these colors are also displayed in the process 
picture of your own project, you must import the corresponding color palette. 

1. In WinCC Explorer, select "OS" and select "Project Properties" from the 
context menu. 

2. Select the "User Interface and Design" tab and click the "Edit" button. 

3. Import the palette with the "Overwrite" option into your own project. The color 
palette is located in the project folder of the Unit Template under the path: 
"<Projektpfad>\UT_Cracker_MP\UT_C_OS\wincproj\OS\GraCS\ 
UnitTemplate.xml>". All existing colors will be replaced. 

 

Note Note that all colors are always used when export/import color palettes. It is not 
possible to export individual color tables.  

 

If you have created your own color tables in your project, you can also export these 
and merge the tables with an editor in the XML file. Alternatively, create a new 
color table in your project and project the colors individually. Also make sure that 
the color index does not change, otherwise you would have to adjust the color 
settings of the objects in the process picture. Of course, it is up to you to change 
the colors according to your requirements. 
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5 Engineering 

5.1 Equipment Modules and Control Modules 

The Unit Template "Steam Cracker" consists of ready-made Equipment Modules 
and additional CFC for e.g. the calculation of the gas and air volume for the burner. 
In the PCS 7 project, all Control Modules, as well as the Control Modules of the 
Equipment Modules, are based on CMTs (Control Module Type) of the master data 
library. 

The application example "Steam Cracker" contains the following components: 

• Inflow (Feed): Control of the educt-steam-mixture 

• Burner control (Heating): Control of the burner 

• MPC control of product properties 

• Soft sensor (SoftSensor): Determination of non-measurable state variables 

• Key Performance Indicators (KPI) 

• Step chain (SFC) for starting the Unit Template 

• Process simulation (Simulation) 

 

Note All necessary descriptions, configurations and procedures pertaining to the  

• design, functionality of equipment modules including parameters 

• integration of equipment modules 

• controllers and control response 

can be found in the application description "Equipment Modules for SIMATIC 
PCS 7 using the example of the Chemical Industry" and the example projects 
with the equipment modules and CMTs at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/53843373 Information on 
the Equipment Modules can be found in the chapter "Equipment Modules" and 
on the CMTs in the chapter "Control Module". 

 

In the following sections you will find the setup of the specific equipment modules 
as well as the extension and modifications made vis-à-vis the original equipment 
modules Control Module Types. In addition, the SFC for starting the Unit Template 
"Steam Cracker" is documented. 

 

Note CMTs are pre-configured for different operating ranges. The use of variants 
allows the corresponding channel block to be selected or deselected based on 
measured value transfer. It is also possible to use options to activate further 
functions without configuring the instance. 

 

https://support.industry.siemens.com/cs/ww/en/view/53843373
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5.2 Inflow (Feed) 

The inflow controls the amount of educt and water vapor, thereby heating the educt 
mixture in the upper part of the cracking furnace. After preheating of the reactant, 
water vapor is fed to the cracking furnace in a defined mixing ratio.  

5.2.1 Setup 

The flow rate of the reactant is specified by the MPC via a setpoint and controlled 
by the flow controller via a proportional valve. In a further step, water vapor is then 
mixed in a defined ratio to the educt, this ratio is regulated with a proportional 
valve. The ratio of water vapor to educt is also specified by the MPC in a narrowly 
defined range (ratio from 0.30 to 0.35). 

The following table provides an overview of the components and control module 
types used. 

CM CMT Selected variants Description 

FFIC_DilutionSteam PIDConRatio • IF_Master 

• PV 

• PV_Scale 

Ratio flow controller for the inflow of 
steam 

FIC_Hydrocarbon PIDCon • IF_Master 

• PV 

• PV_Scale 

Flow controller for the inflow of the 
educt 

YC_DilutionSteam VlvAn • IF_Ctrl 

• GI 

• MV_Scale 

• YC 

Control valve for the inflow of water 
vapor 

YC_Hydrocarbon VlvAn • IF_Ctrl 

• GI 

• MV_Scale 

• YC 

Control valve for the inlet of the 
educt 
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In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 

MPC

SIMIT

FIC_Hydrocarbon

from_Actor_Slave

In

to_Master

Out

from_Master

SP_Ext

YC_Hydrocarbon

to_Ctrl

Out

from_Ctrl

In

YC

PV_Out

to_Ctrl3

Out

from_Ctrl3

In

to_Actor_Slave

Out

PV_In

PV_In

IN

MV_Hydrocarbon

MV_ DilutionSteam

OUT

PV_Hydrocarbon

PV_DilutionSteam

YC_DilutionSteam

YC

PV_Out

from_Ctrl

In

to_Ctrl

Out

to_Ctrl2

Out

from_Ctrl2

In

FFIC_DilutionSteam

from MPC

In

to_MPC

Out

from_Master

In

from_Actor_Slave

In

to_Actor_Slave

Out

PV_In

PV_In

 

 

5.2.2 Parameter assignment 

FFIC_DilutionSteam 

With the Control Module "FFIC_DilutionSteam" the addition of water vapor is 
recorded and controlled in relation to the educt. The setpoint is specified by the 
master controller "FIC_Hydrocarbon", the ratio is specified by the MPC 
"XC_Product" within a narrow range. The Control Module "FFIC_DilutionSteam" 
transmits the output value to the valve Control Module "YC_DilutionSteam". The 
Control Module "FFIC_DilutionSteam" is an instance of the Control Module Type 
"PIDConRatio" and has been extended by an additional connection to the MPC to 
specify the relationship with the additional communication blocks. 

The following table shows the project engineering of the instance. 

Block Connection Value Use 

C Gain 1.881 Controller gain 

C TI 9.119 Controller lag 

C PV_Out  Connection for KPI calculation 
(FI_ThroughputC2H4\Flow*Yield.In1) 

to_Actor_Slave Out  Connection to valve 
(YC_DilutionSteam\from_Ctrl.In) 

from_Actor_Slave In  Connection of the valve 
(YC_DilutionSteam\to_Ctrl.Out) 

from_Master In  Connection of the master controller 
(FIC_Hydrocarbon\to_Actor_Slave.Out) 

to_MPC ReStru1  Merging the wiring to the MPC 
(FFIC_DilutionSteam\Ratio.RatioPV) 

to_MPC BoStru1  Merging the wiring to the MPC 
(FFIC_DilutionSteam\Ratio.RatExtAc) 
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Block Connection Value Use 

to_MPC Scale1.High 
Scale1.Low 

0.5 
0.25 

Range limits for the ratio 

to_MPC Out  Connection to MPC 
(XC_Product\from_Ctrl3.In) 

from_MPC In  Connection from MPC 
(XC_Product\to_Ctrl3.In) 

from_MPC ReStru1  Merging the wiring to the MPC 
(FFIC_DilutionSteam\Ratio.RatioExt) 

from_MPC BoStru2  Merging the wiring to the MPC 
(FFIC_DilutionSteam\OosAct.In6) 

Ratio RatioPV  Output of the current ratio 
(FFIC_DilutionSteam\toMPC.ReStru1) 

Ratio RatExtAc  External specification of the ratio 
(FFIC_DilutionSteam\toMPC.BoStru1) 

Ratio RatExtLi 1 Activate external specification of the ratio 

OosAct In6  Merge Out of Service 
(FFIC_DilutionSteam\from_MPC.BoStru2) 

PV_In PV_In  Interconnection for the simulated process 
value 
(Process\Add_Noise_Diluti.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 25.0 Maximum value of the process value 

PV_Unit IN 1328 Unit of the process value (t/h) 

 

FIC_Hydrocarbon 

With the Control Module "FIC_Hydrocarbon" the addition of the reactant is 
recorded and controlled. The setpoint is set by the MPC. The Control Module 
"FIC_Hydrocarbon" transmits the controller output value to the valve Control 
Module "YC_Hydrocarbon". The Control Module "FIC_Hydrocarbon" is an instance 
from the Control Module Type "PIDCon".  

The following table shows the project engineering of the instance. 

Block Connection Value Use 

C Gain 0.588 Controller gain 

C TI 6.142 Controller lag 

C PV_Out  Connection for KPI calculation 
(FI_ThroughputC2H4\Flow*Yield.In1) 

to_Actor_Slave Out  Connection to valve 
(YC_Hydrocarbon\from_Ctrl.In) 
(FFIC_DilutionSteam\from_Master.In) 

from_Actor_Slave In  Connection of the valve 
(YC_Hydrocarbon\to_Ctrl.Out) 

to_Master Out  Connection to MPC 
(XC_Product\from_Ctrl2.In) 

from_Master In  Connection from MPC 
(XC_Product\to_Ctrl2.Out) 

PV SimPV_In  Interconnection for the simulated process 
value 
(Process\Add_Noise_Hydroc.Out) 
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Block Connection Value Use 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 50.0 Maximum value of the process value 

PV_Scale LoScale 1.0 Minimum value of the process value 

PV_Unit IN 1328 Unit of the process value (t/h) 

 

YC_DilutionSteam 

The valve Control Module "YC_DilutionSteam" controls the supply of steam to the 
cracking furnace. The valve module receives the external setpoint via 
communication modules from the controller Control Module "FFIC_DilutionSteam". 

The following table shows the project engineering of the instance from "VlvAn". 

Block Connection Value Use 

from_Ctrl   Interconnection for the controller 
(FFIC_DilutionSteam\from_Actor_Slave.Out) 

to_Ctrl   Interconnection for the controller 
(FFIC_DilutionSteam\to_Actor_Slave.Out) 

Y MV  Interconnection for the simulation 
(Process\PT1_YC_DilutionS.In) 

GI SimPV_In  Connection of the simulation 
(Process\PT1_YC_DilutionS.Out) 

GI SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

 

YC_Hydrocarbon 

The valve Control Module "YC_Hydrocarbon" controls the flow of the reactant into 
the cracking furnace. The valve module receives the external setpoint via 
communication modules from the controller Control Module "FIC_Hydrocarbon". 

The following table shows the project engineering of the instance from "VlvAn". 

Block Connection Value Use 

from_Ctrl   
Interconnection for the controller 
(FIC_Hydrocarbon\from_Actor_Slave.Out) 

to_Ctrl   
Interconnection for the controller 
(FIC_Hydrocarbon\to_Actor_Slave.Out) 

Y MV  
Interconnection for the simulation 
(Process\PT1_YC_Hydrocarb.In) 

GI SimPV_In  
Connection of the simulation 
(Process\PT1_YC_Hydrocarb.Out) 

GI SimOn  
Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 
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5.3 Burner control (Heating) 

For the chemical reactions, a temperature of the educt/water vapor mixture of 
approx. 840°C is required. The gas burner in the furnace chamber is controlled in 
order to achieve this predetermined temperature inside the coil. 

5.3.1 Setup 

The burner is controlled via a burner load specified by the MPC and the "Gas Air 
Ratio Controller (GARC)". The GARC calculates the required amount of gas and 
combustion air from the burner load, which is supplied in the correct stoichiometric 
ratio to the fuel. This ensures that a defined minimum excess of air is maintained in 
both stationary and dynamic operating conditions in order to guarantee a safe 
system condition. The GARC is part of the PCS 7 Unit Template – Gas Fired 
Steam Boiler \9\. The calculated quantity of gas and air from the burner is 
controlled by subordinate PID controllers with proportional valves. 

 

The following table provides an overview of the components and control module 
types used. 

CM CMT Selected variants Description 

FIC_Air PIDCon • PV 

• PV_Scale 

Flow controller for the inflow of air 
into the burner 

FIC_FuelGas PIDCon • IF_Master 

• PV 

• PV_Scale 

Flow controller for the inflow of fuel 
gas 

QI_O2Concentration MonAn • PV 

• PV_Scale 

Control Module for indication of the 
oxygen concentration 

YC_Air VlvAn • IF_Ctrl 

• GI 

• MV_Scale 

• YC 

Control valve for the inflow of air 
into the burner 

YC_FuelGas VlvAn • IF_Ctrl 

• GI 

• MV_Scale 

• YC 

Control valve for fuel gas inflow 

In addition to the four CMTs mentioned above, the CFC "GARC" is used, which 
converts burner load to required quantity of gas and combustion air. 
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In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 
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SP_Ext

to_Actor_Slave

Out

PV_In

PV_In

YC_FuelGas

YC

PV_Out

from_Ctrl

In

to_Ctrl

Out

to_Ctrl1

Out

from_Ctrl1

In

to_Master

Out

C

PV_Out

from_Actor_Slave

In

GARC

LOAD_TO_01

In1

GARC_SP

AIR

GAS

GARC_SP

GAS_SP

AIR_SP

IN

MV_AIR

MV_GAS

OUT

PV_O2Concentration

PV_Gas

FIC_Air

AIF_SFC

SP_Ext

C

PV_Out

PV_In

PV_In

YC_Air

YC

PV_Out

from_Ctrl

In

to_Ctrl

Out

to_Actor_Slave

PV

from_Actor_Slave

In

PV_Air

QI_ O2Concentration

PV_In

PV_In

 

5.3.2 Parameter assignment 

FIC_Air 

The "FIC_Air" Control Module is used to measure and regulate the air flow rate. 
The setpoint value for the air volume is set by the GARC. The Control Module 
"FIC_Air" transmits the controller output value to the valve Control Module 
"YC_Air". The measurement loop "FIC_Air" is an instance from the Control Module 
Type "PIDCon". 

The following table shows the project engineering of the instance. 

Block Connection Value Use 

C Gain 1.88 Controller gain 

C TI 7.282 Controller lag 

C PV_Out  Connection to GARC 
(GARC\GARC_SP.AIR) 

C SP_InHiL 4000.0 Upper limit of the internal setpoint 
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Block Connection Value Use 

to_Actor_Slave Out  Connection for the valve 
(YC_Air\from_Ctrl.In) 

from_Actor_Slave In  Connection to valve 
(YC_Air\to_Ctrl.Out) 

PV SimPV_In  Interconnection for the simulated process 
value 
(Process\Add_Noise_Air.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 4000.0 Maximum value of the process value 

PV_Unit IN 4 Unit of the process value (kmol/h) 

 

FIC_FuelGas 

With the Control Module "FIC_FuelGas" the inflow of the fuel gas is recorded and 
controlled. The setpoint for the amount of fuel gas is also set by the GARC. The 
Control Module "FIC_FuelGas" transmits the controller output value to the valve 
Control Module "YC_FuelGas". The Control Module "FIC_FuelGas" is an instance 
from the Control Module Type "PIDCon". 

The following table shows the project engineering of the instance. 

Block Connection Value Use 

C Gain 4.121 Controller gain 

C TI 9.989 Controller lag 

C PV_Out  Connection to GARC 
(GARC\GARC_SP.AIR) 

C SP_InHiL 600.0 Upper limit of the internal setpoint 

to_Actor_Slave Out  Connection for the valve 
(YC_FuelGas\from_Ctrl.In) 

from_Actor_Slave In  Connection to valve 
(YC_FuelGas\to_Ctrl.Out) 

PV SimPV_In  Interconnection for the simulated process 
value 
(Process\Add_Noise_FuelGa.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 600.0 Maximum value of the process value 

PV_Unit IN 4 Unit of the process value (kmol/h) 

 

GARC 

The "GARC" Control Module calculates the setpoints for the "FIC_FuelGas" and 
"FIC_Air" controllers from the MPC burner load output value. This ensures that a 
defined minimum excess of air is maintained in both stationary and dynamic 
operating conditions in order to guarantee a safe system condition. 

Usually, the control of a burner is implemented with additional error protection 
measures, such as fail-safe components from the F-System area. The fail-safe 
implementation as well as a detailed description of the function and structure of the 
GARC can be found in the PCS 7 Unit Template – Gas Fired Steam Boiler \9\. 
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The following table shows the connection of the Control Module from "GARC". 

Block Connection Value Use 

LOAD_TO_01 In1  
Setpoint specification of MPC 
(XC_Product\from_Master.Out) 

GARC_SP GAS  
Actual value of the flow to burner gas 
(FIC_FuelGas\C.PV_Out) 

GARC_SP AIR  
Actual value of the flow to burner gas 
(FIC_Air\C.PV_Out) 

GARC_SP SP_GAS  
Actual value of the flow to burner gas 
(FIC_FuelGas\AIF_SFC.SP_Ext) 

GARC_SP SP_AIR  
Actual value of the flow to burner gas 
(FIC_Air\AIF_SFC.SP_Ext) 

 

QI_O2Concentration 

The display Control Module "QI_O2Concentration" visualizes the amount of 
remaining oxygen after combustion. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Process\Noise_QI_O2.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 21.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1342 Process value unit (%) 

To_Indicate Out  Connection to the controlled variable of the 
multi-variable controller 

(XC_Product\from_CV4.In) 

 

YC_Air 

The valve Control Module "YC_Air" controls the air flow into the burner. The valve 
module receives the external setpoint via communication modules from the 
controller Control Module "FIC_Air". 

The following table shows the project engineering of the instance from "VlvAn". 

Block Connection Value Use 

from_Ctrl   
Interconnection for the controller 
(FIC_Air\from_Actor_Slave.Out) 

to_Ctrl   
Interconnection for the controller 
(FIC_Air\to_Actor_Slave.Out) 

Y MV  
Interconnection for the simulation 
(Process\PT1_YC_Air.In) 

GI SimPV_In  
Connection of the simulation 
(Process\PT1_YC_Air.Out) 

GI SimOn  
Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 
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YC_FuelGas 

The valve Control Module "YC_FuelGas" controls the fuel gas into the burner. The 
valve module receives the external setpoint via communication modules from the 
controller Control Module "FIC_FuelGas". 

The following table shows the project engineering of the instance from "VlvAn". 

Block Connection Value Use 

from_Ctrl   
Interconnection for the controller 
(FIC_FuelGas\from_Actor_Slave.Out) 

to_Ctrl   
Interconnection for the controller 
(FIC_FuelGas\to_Actor_Slave.Out) 

Y MV  
Interconnection for the simulation 
(Process\PT1_YC_FuelGas.In) 

GI SimPV_In  
Connection of the simulation 
(Process\PT1_YC_FuelGas.Out) 

GI SimOn  
Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 
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5.4 MPC 

The aim of the control is, on the one hand, to keep the quantity of ethylene and 
propylene produced as high as possible and, at the same time, to achieve a high 
conversion rate of the starting materials. The material conversion of the long-chain 
hydrocarbons to the desired main products depends on many influencing factors 
and is therefore controlled by a corresponding multi-variable control concept. 

The overall tasks of the MPC are as follows: 

• Production quantity: Drive ethylene throughput to defined setpoint 

• Product quality: Keep conversion rate of ethane (measure for "Severity") on 
target value 

• Limit coking: keep COT ("Coil Outlet Temperature") in specified range 

• Safe plant operation: Keep TMT ("Tube Metal Temperature") below critical 
upper limit 

• Find a suitable setpoint combination for the inlet of the duct, process steam 
and fuel gas. 

5.4.1 Setup 

MPC 4x3

MV1CV1

CV2

CV3

deadband

CV4

deadband

Inlet setpoint

fuelgas
Ethylen throughput

Conversion rate

ethane

COT

MV2

MV3

TMT

Inlet setpoint

educt

ratio of water vapor 

to educt

 

In order to achieve the above objectives, the MPC sets the target value for the 
GARC and thus indirectly the burner inflow in the form of fuel gas and air. In 
addition, the inflow of the reactant is predetermined. The ratio of water vapor to 
educt is influenced by the MPC as the third manipulated variable, but the permitted 
range for this ratio is very narrow. This leads to the fact that the manipulated 
variable limitation is active and thus to a limited influence of the third MPC 
manipulated variable. Although the MPC theoretically has three degrees of 
freedom, usually only two of them can be used. As only two degrees of freedom 
are effectively available due to the limited number of manipulated variables, 
additional controlled variables can no longer be precisely controlled to the setpoint. 
In order to nevertheless guarantee a safe plant condition, the temperatures COT 
("Coil Outlet Temperature") and TMT ("Tube Metal Temperature") are kept within 
tolerance bands by the MPC as additional controlled variables. As soon as one of 
the two temperatures threatens to leave the tolerance range, they are considered 
by the MPC with high priority. 

In total this results in a 4x3 MPC. Here, however, the third manipulated variable 
can only be used to a very limited extent. As long as both temperature control 
variables are within the permitted range, the control task is effectively reduced to a 
2x2 problem that can be easily mastered by the MPC. 



5 Engineering 

 

UT Steamcracker 
Entry ID: 109769355,    V1.0,    10/2019   41 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

The following table provides an overview of the components and control module 
types used. 

CM CMT Selected variants Description 

XC_Product ModPreCon • IF_Ctrl_1 

• IF_Ctrl_2 

• IF_Ctrl_3 

• IF_Ctrl_4 

Multivariable controller as master 
controller 

FI_EthylenThroughput MonAn • PV 

• PV_Scale 

• To_Indicate 

Control Module for indication of 
ethylene throughput 

QI_ConversionEthan MonAn • PV 

• PV_Scale 

• To_Indicate 

Control Module for displaying the 
conversion rate of the ethane supplied 

QI_YieldC2H4 MonAn • PV 

• PV_Scale 

• To_Indicate 

Control Module to display the amount of 
ethylene produced 

TI_COT MonAn • PV 

• PV_Scale 

• To_Indicate 

Control Module to display the output 
temperature of the coil (COT = Coil 
Outlet Temperature) 

TI_TMT MonAn • PV 

• PV_Scale 

• To_Indicate 

Control Module for displaying the shell 
temperature of the tube metal (TMT = 
Tube Metal Temperature) 
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In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 
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5.4.2 Parameter assignment 

XC_Product 

The following variables are used and connected for control with the multi-variable 
controller Control Module "XC_Product". 

CVs (Controlled Variables): 

• CV1 Conversion rate of ethane 

• CV2 Ethylene throughput 

• CV3 Temperature at the output of the coil 

• CV4 Temperature of the tube metal 

MVs (Manipulated Variables, setpoint values for subordinate slave controllers): 

• MV1 Burner load 

• MV2 Flow rate of the educt 

• MV3 Educt/water vapor ratio 

The measurement loop contains communication modules for connecting slave 
controllers and for displaying control variables and is an instance of the 
"ModPreCon" measurement loop type. 

Block Connection Value Use 

MPC SP1 65.849 Setpoint for control variable 1 

MPC SP2 10.302 Setpoint for control variable 2 

MPC SP3 855.0 Setpoint for control variable 3 

MPC SP4 1000.0 Setpoint for control variable 4 

MPC SP1DeadB 0.0 Dead band for control variable 1 

MPC SP2DeadB 0.0 Dead band for control variable 2 

MPC SP3DeadB 20.0 Dead band for control variable 3 

MPC SP4DeadB 50.0 Dead band for control variable 4 

MPC PreFilt1 0.0 Settling time for control variable 1 

MPC PreFilt2 0.0 Settling time for control variable 2 

MPC PreFilt3 20.0 Settling time for control variable 3 

MPC PreFilt4 50.0 Settling time for control variable 4 

MPC MV1Man 375.0 Control value in manual mode 

MPC MV2Man 19.35 Control value in manual mode 

MPC MV3Man 0.315 Control value in manual mode 

MPC MV4Man 0.0 Control value in manual mode 

MPC DB_No 18 DB number with controller data 

from_CV1 In  

Connection of the conversion rate of the 
ethane supplied 
(QI_ConversionEthan\to_Indicate.Out) 

from_CV2 In  
Connection of ethylene throughput 
(QI_EthylenThroughput\to_Indicate.Out) 

from_CV3 In  

Connection of the temperature at the 
output of the coil 
(TI_COT\to_Indicate.Out) 

from_CV4 In  

Connection of the temperature of the tube 
metal 
(TI_TMTI\to_Indicate.Out) 
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Block Connection Value Use 

to_Ctrl1 Out  
Control value for burner load 
(FIC_FuelGas\from_Master.In) 

to_Ctrl2 Out  
Control value for educt flow rate 
(FIC_Hydrocarbon\from_Master.In) 

to_Ctrl3 Out  

Control value for the educt/water vapor 
ratio 
(FIC_Catalyst\from_Master.In) 

from_Ctrl1 In  

Connection from the burner gas Control 
Module 
(FIC_FuelGas\to_Master.Out) 

from_Ctrl2 In  
Connection of the educt Control Module 
(FIC_Hydrocarbon\to_Master.Out) 

from_Ctrl3 In  
Connection of the ratio Control Module 
(FFIC_DilutionSteam\to_MPC.Out) 

 

FI_EthylenThroughput 

The display Control Module "FI_EthylenThroughput" visualizes the ethylene 
throughput and is used to provide the process value for the MPC. 

However, the ethylene throughput could only be measured with a long dead time in 
the separation section of the entire cracker plant, so the throughput is calculated as 
follows: 

𝐸𝑡ℎ𝑦𝑙𝑒𝑛𝑇ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 = 𝐹𝑒𝑒𝑑𝐻𝑦𝑑𝑟𝑜𝑐𝑎𝑟𝑏𝑜𝑛 ∙  𝑌𝑖𝑒𝑙𝑑𝐶2𝐻4 

The inflow from the hydrocarbon is controlled by the controller "FIC_Hydrocarbon" 
and the conversion rate to ethylene is calculated by the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\ThroughputC2H4) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 50.0 Maximum value of the process value 

PV_Scale LoScale 1.0 Minimum value of the process value 

PV_Unit IN 1328 Unit of the process value (t/h) 

To_Indicate Out  Connection to the controlled variable of the 
multi-variable controller 

(XC_Product\from_CV2.In) 

 



5 Engineering 

 

UT Steamcracker 
Entry ID: 109769355,    V1.0,    10/2019   45 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

9
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

QI_ConversionEthan 

The display Control Module "QI_ConversionEthan" visualizes the conversion rate 
of the supplied ethane (C2H6), which is calculated by the soft sensor. The 
measurement loop provides the process value for the MPC. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\ConvEthan.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1342 Process value unit (%) 

To_Indicate Out  Connection to the controlled variable of the 
multi-variable controller 
(XC_Product\from_CV1.In) 

 

QI_YieldC2H4 

The display Control Module "QI_YieldC2H4" visualizes the yield of ethylene 
(C2H4), which is calculated by the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\YieldC2H4.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1342 Process value unit (%) 

I PV_Out  Wiring for ethylene throughput calculation 
(FI_EthylenThroughput\Flow*Yield.In2) 

 

TI_COT 

The display Control Module "TI_COT" visualizes the temperature at the output of 
the coil and is used to provide the process value for the MPC. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\COT.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 800.0 Maximum value of the process value 

PV_Scale LoScale 600.0 Minimum value of the process value 
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Block Connection Value Use 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 

To_Indicate Out  Connection to the controlled variable of the 
multi-variable controller 
(XC_Product\from_CV3.In) 

TI_TMT 

The display Control Module "TI_TMT" visualizes the jacket temperature of the 
pass, which is calculated by the soft sensor. The measurement loop provides the 
process value for the MPC. 
The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\TMT.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 800.0 Maximum value of the process value 

PV_Scale LoScale 600.0 Minimum value of the process value 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 

To_Indicate Out  Connection to the controlled variable of the 
multi-variable controller 
(XC_Product\from_CV4.In) 
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5.5 Soft sensor (SoftSensor) 

The yield and the conversion rate are of decisive importance for the economic 
efficiency of a steam cracker. However, the material and reaction properties cannot 
be determined directly at the outflow of the cracking furnace, but only with great 
delay at the downstream subsystems and often summarized for several cracking 
furnaces. This delay makes direct control impossible. Therefore, a soft sensor 
calculates the variables that are of decisive importance for process control and 
thus enables the direct control concept of theses variable. 

To calculate the ethane conversion rate and ethylene yield, the soft sensor uses a 
simulated dynamic process model and the current values of the input variables into 
the system. The internal system states to be measured are compared with the 
corresponding measured values of the real process and used to correct the 
estimated states. 

For applications in real plants, the model-based soft sensor for each cracking 
furnace is implemented in PSE's simulation software gPROMS and coupled to 
SIMATIC PCS 7 via OPC UA. 

Coupled differential-algebraic equations are used to realistically map the system 
behavior of a steam cracker. More than 50,000 equations are required for the 
"Steam Cracker" model, so implementation of the soft sensor in SIMATIC PCS 7 is 
not possible. In this Unit Template, the non-measurable variables are simulated 
and made available in the simulation, therefore the Equipment Module 
"SoftSensor" only contains the Control Modules for correcting the internal 
measured states of the soft sensor. 

5.5.1 Setup 

In the "SoftSensor" Equipment Module, the Control Modules are available which 
are measured at the system and used to correct the estimated states. 

The following table provides an overview of the components and control module 
types used. 

CM CMT Selected variants Description 

PI_CIP MonAn • PV 

• PV_Scale 

Control Module for indicating the 
pressure at the inlet of the tube bundle 
(CIP = Coil inlet Pressure) 

PI_COP MonAn • PV 

• PV_Scale 

Control Module for indicating the 
pressure at the outlet of the tube bundle  
(COP = Coil Outlet Pressure) 

QI_FG_H2 MonAn • PV 

• PV_Scale 

Control Module for indicating the 
proportion of H2 (hydrogen) in the 
burner gas 

QI_HC_C3H8 MonAn • PV 

• PV_Scale 

Control Module for displaying the 
proportion of C3H8 (propane) in the 
feed educt 

TI_Air MonAn • PV 

• PV_Scale 

Control Module for displaying the 
temperature of the air volume in the 
burner 

TI_CIT MonAn • PV 

• PV_Scale 

Control Module to display the input 
temperature of the tube bundle  
(CIT = Coil Inlet Temperature) 

FIC_FuelGas MonAn • PV 

• PV_Scale 

Control Module for display of burner 
gas temperature 
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CM CMT Selected variants Description 

TI_Hydrocarbon MonAn • PV 

• PV_Scale 

Control Module to display the 
temperature of the reactant 

No Control Module is provided for the temperature of the water vapor, as the water 
vapor is usually supplied from a central steam supply within the plant and therefore 
the temperature has a relatively small fluctuation range. A constant value is 
assumed in the simulation. 

The Equipment Module "SoftSensor" has no cross-chart connections, the 
corresponding values for the display Control Modules are provided by the 
simulation. 

 

5.5.2 Parameter assignment 

PI_CIP 

The display Control Module "PI_CIP" visualizes the pressure at the input of the coil 
and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\Noise_PI_CIP.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1137 Unit of the process value (bar) 

 

PI_COP 

The display Control Module "PI_COP" visualizes the pressure at the output of the 
coil and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\Noise_PI_COP.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 2.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1137 Unit of the process value (bar) 
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QI_FG_H2 

The display Control Module "QI_FG_H2" visualizes the proportion of hydrogen in 
the burner gas and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\Noise_QI_FG_H2.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1342 Unit of the process value (percent) 

 

QI_HC_C3H8 

The display Control Module "QI_HC_C3H8" visualizes the proportion of propane 
(C3H8) in the educt and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\Noise_QI_HC_C3H8.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1342 Unit of the process value (percent) 

 

TI_Air 

The display Control Module "TI_Air" visualizes the temperature of the air volume in 
the burner and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Process\Noise_TI_Air.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 10.0 Minimum value of the process value 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 
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TI_CIT 

The display Control Module "TI_CIT" visualizes the temperature at the input of the 
pass and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Softsensor\Noise_TI_CIT.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 800.0 Maximum value of the process value 

PV_Scale LoScale 600.0 Minimum value of the process value 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 

 

TI_Fuelgas 

The display Control Module "TI_Fuelgas" visualizes the temperature of the burner 
gas and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Process\Noise_TI_FuelGas.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 10.0 Minimum value of the process value 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 

 

TI_Hydrocarbon 

The display Control Module "TI_Hydrocarbon" visualizes the temperature of the 
reactant and is used to provide the process value for the soft sensor. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV SimPV_In  Interconnection for the simulated process value 
(Process\Noise_TI_Hydroca.Noise) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Scale LoScale 10.0 Minimum value of the process value 

PV_Unit PV_InUnit 1001 Process value unit (ºC) 
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5.6 Key Performance Indicators (KPI) 

In addition to the four process characteristics, yield, conversion rate, coil outlet 
temperature (COT) and tube metal temperature (TMT), for the control concept of 
the multi-variable controller, the soft sensor calculates further material and reaction 
properties that are not determined directly at the outlet of the cracking furnace.  

5.6.1 Setup 

The Equipment Module "KPI" contains the visualization of further key performance 
indicators, which inform the operator about further material and reaction properties 
of the process. The properties: 

• Severity P/E (Propylene/Ethylene) 

• Severity M/P (Methane/Propylene) 

• Coking rate 

are formed by the soft sensor through the parallel simulation of a process model 
and visualized via additional display Control Modules. 

In addition, further yield coefficients can be calculated by the soft sensor, such as 
the yields of 

• Propylene 

• Methane 

• Hydrogen 

• Acetylene 

• C4s 

• C5plus 

For reasons of clarity, however, these Control Modules are not implemented. 

The following table provides an overview of the components and control module 
types used. 

CM CMT Selected variants Description 

PI_PressureDrop MonAn • PV 

• PV_Scale 

Control Module for displaying the 
pressure difference between the 
furnace inlet and outlet 

QI_CokeLevel MonAn • PV 

• PV_Scale 

Control Module for indicating the 
thickness of deposits on the pipes 

QI_CokingRate MonAn • PV 

• PV_Scale 

Control Module for display the increase 
in thickness of deposits 

QI_SeverityMP MonAn • PV 

• PV_Scale 

Control Module for indicating the ratio 
of methane to propylene 

QI_SeverityPE MonAn • PV 

• PV_Scale 

Control Module for indicating the ratio 
of propylene to ethylene 
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5.6.2 Parameter assignment 

PI_PressureDrop 

The display Control Module "PI_PressureDrop" visualizes the pressure difference 
between the furnace inlet and outlet. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV PV_In  Interconnection for the simulated process value 
(Softsensor\PressDrop.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 5.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1137 Unit of the process value (bar) 

 

QI_CokeLevel 

The display Control Module "QI_CokeLevel" visualizes the thickness of deposits on 
the pipes calculated by the soft sensor. The deposits change the heat transfer 
between the outside and inside of the pipes. In case of excessive contamination, it 
is more economical to switch off the system and clean the pipes. The Control 
Module thus enables cleaning to be carried out at the best economic time. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV PV_In  Interconnection for the simulated process value 
(Softsensor\Initial value.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 2000.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1013 Process value unit (mm) 

 

QI_CokingRate 

The display Control Module "QI_CokingRate" visualizes the increase of deposits on 
the pipes, this is calculated by the soft sensor. The Control Module makes it 
possible to plan the times for cleaning at an early stage. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV PV_In  Interconnection for the simulated process value 
(Softsensor\CokingRate.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 20.0 Maximum value of the process value 
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Block Connection Value Use 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 1 Process value unit (mm/month) 

 

Note The Unit Template uses customer-specific units that deviate from the IEC 
611582 standard. These units are defined in the "APLCustomerUnits.xml" and 
are located in the project path in the folder "GraCS". 
Further information on the customer-specific units can be found in the function 
manual "SIMATIC Process Control System PCS 7 Advanced Process Library 
(V9.0 SP2)". The function manual can be found under 
https://support.industry.siemens.com/cs/ww/en/view/109760968 

 

QI_SeverityMP 

The display Control Module "QI_SeverityMP" visualizes the concentration of 
methane in propylene. The severity can only be estimated by a soft sensor at 
runtime. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV PV_In  Interconnection for the simulated process value 
(Softsensor\SeverityMP.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 10.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 3 Process value unit (%/%) 

 

QI_SeverityPE 

The display Control Module "QI_SeverityMP" visualizes the concentration of 
propylene to ethylene. The severity can only be estimated by a soft sensor at 
runtime. 

The following table shows the project engineering of the instance from "MonAn". 

Block Connection Value Use 

PV PV_In  Interconnection for the simulated process value 
(Softsensor\SeverityPE.Out) 

PV SimOn  Switching between SIMIT and PLCSIM 
(SIMIT_PCS7\S.Out) 

PV_Scale HiScale 10.0 Maximum value of the process value 

PV_Scale LoScale 0.0 Minimum value of the process value 

PV_Unit PV_InUnit 3 Process value unit (%/%) 

https://support.industry.siemens.com/cs/ww/en/view/109760968
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5.7 Sequential Functional Chart (SFC) 

Sequential Functional Charts support the plant operator in starting up and shutting 
down a facility, and in the event of faults, and can be adapted to specific 
circumstances. 

The "Steam Cracker" is designed for continuous operation, where individual 
parameters (educt inflow or educt to steam ratio) can change slightly during the 
running process. The steam cracker contains the SFC "StartUp" to start up the Unit 
Template and simulation, which leads the individual components of the steam 
cracker into the respective operating points.  

When the steam cracker is started, a controller or actuator changes to automatic 
mode with external setpoint in each step. In the transition that follows, the 
"Automatic" operating mode and control deviation are checked. Finally, the 
setpoints for the controlled variables of the multi-variable controller are specified. 

This SFC is only to be understood as a reference point with regard to real steam 
crackers and was created to match the simulation requirements. For use in real 
systems, start-up controlling must be created according to the process-related 
requirements. For example, it must be clarified whether the steam cracker is first 
filled with educt and then steam is added, or vice versa. 

 

Note To determine the setpoint and operation selection, the necessary 
parameterization including the schematic diagrams from the function manual 
"SIMATIC Process Control System PCS 7 Advanced Process Library  
(V9.0 SP2)" was used. The function manual can be found under 
https://support.industry.siemens.com/cs/ww/en/view/109760968. 

 

https://support.industry.siemens.com/cs/ww/en/view/109760968
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6 Process simulation 
To demonstrate the Unit Template the simulation is realized with PLCSIM and 
SIMIT. During simulation with PLCSIM, the application program is loaded into a 
virtual AS, whereby the process is simulated in a CFC chart. With SIMIT, the 
signals, devices and the process are simulated outside of PCS 7. Both simulations 
are independent of each other and thus allow you to select the type of simulation, 
depending on the available license. The task of process simulation is to understand 
or demonstrate the functionality of the steam cracker, especially with regard to the 
control functions of the multi-variable controller. There is no claim to exactly 
reproduce the real physical behavior of a particular cracker.  

The gas phase reaction in the coils should be simulated as a system with spatially 
distributed parameters though this is not the case for this template. The thermal 
behavior of the entire furnace with the heat capacities of the steel masses is not 
considered, therefore the current cracker model has no delay time constants 
greater than 10 s. This is realistic for the gas phase reaction, but not for the 
temperature control systems. 

All measurable values are simulated in SIMIT (respectively in PCS 7 when SIMIT is 
not used). In the template no external soft-sensor is coupled but the calculations 
are simulated in PCS 7 in a simplified way. 
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6.1 Simulation with SIMIT 

SIMIT offers a simple possibility for the simulation of signals, devices and process 
states. The simulation contains several prefabricated, standardized and fully 
interconnected device and process simulations and consists of three levels: 

• Signal level 

• Device level 

• Process level 

In the signal level, system signals are defined and scaled with the help of the 
symbol table (export from PCS 7). 

In the device level, devices such as valves and motors are defined and connected 
to the respective signals of the signal level via connectors. 

At the process level, physical processes such as material flows are modeled on the 
basis of states (e.g. valve position) and other parameters (e.g. maximum flow rate). 

 

Procedure 

The following representation describes the procedure of how to create a simulation 
model with SIMIT. 

Create SIMIT 
project

Operation

Create devices

Create signals

Create process 
model

Kommentar

Use the PCS 7 symbole
table import function

Use the PCS 7 CMT 
import function

 

 

Note You can find a detailed description of how to create a simulation model in SIMIT 
in the application example "Simulation with SIMIT and SIMATIC PCS 7 using a 
practical example" under the following link: 
https://support.industry.siemens.com/cs/ww/en/view/77362399 

 

https://support.industry.siemens.com/cs/ww/en/view/77362399
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6.1.1 Signals 

In SIMIT, all signals required for communication are created in so-called couplings. 
In project, the couplings with PLCSIM have already been created and configured. 

The process values are transmitted as raw data values. In SIMIT, the 
standardization takes place in the simulation plans. In PCS 7, these raw data are 
converted into process values in the driver blocks. 
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6.1.2 Device simulation 

The structure of the SIMIT project is derived from the plant hierarchy of the PCS 7 
project. The plans for simulating the corresponding actuators and sensors are 
configured in the individual folders. In addition, each relevant folder contains a 
chart for simulating the process values. 

Frei verwendbar
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6.1.3 Process simulation 

For the simulation of the process values, an additional chart ("Process_xxx") is 
implemented in each relevant folder. The simulation of the process values is 
reduced to a minimum for reasons of complexity. 

In some cases, static values were used, to which only a measurement noise was 
added. The static values can be adjusted in SIMIT using an input field. 

 

 

For controlled processes, the valve position is used with a factor plus measurement 
noise as the process value to be controlled. 
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6.1.4 Simulation overview 

To visualize the simulation process, the chart "Steam Cracker" in the folder 
"Charts" is used. This chart displays all values, which are simulated in SIMIT. 
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6.2 Simulation with PLCSIM 

During simulation with PLCSIM, the required feedback and processes are 
simulated in the CFC. For valve feedback, the manipulated variable is delayed via 
PT1 element and transmitted to the valve module as a position feedback signal. 
From the simulated feedback of the valve, the respective flow rate is simulated by a 
first-order linear transfer function and made available for control. 

6.2.1 Simulation for the Equipment Module "Feed" 

1

2 3

4

4

5

6 7

8

8

 

1. Delay of the control of the valve for the supply of water vapor (PT1 behavior 
with 9.3 s delay) 

2. Conversion of the valve opening into a flow of air (100 % valve opening 
corresponds to an inlet of 25 t/h) 

3. Flow delay (PT1 behavior with 1.2 s delay) 

4. Creation of measurement noise 

5. Delay in actuating the valve for the feed of the reactant (PT1 behavior with 
7.0 s delay) 

6. Conversion of the valve opening into a flow of the reactant (100 % valve 
opening corresponds to an inlet of 50 t/h) 

7. Flow delay (PT1 behavior with 1.0 s delay) 

8. Generation of measurement noise 
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6.2.2 Simulation for the "Heating" Equipment Module 

1

2 3

4

4

5

6 7

8

8

 

1. Delay in controlling the valve for the supply of air (PT1 behavior with 7.6 s 
delay) 

2. Conversion of the valve opening into a flow of air (100 % valve opening 
corresponds to an inlet of 4000 kmol/h) 

3. Flow delay (PT1 behavior with 0.7 s delay) 

4. Creation of measurement noise 

5. Delay of the control of the valve for the supply of fuel gas (PT1 behavior with 
10.0 s delay) 

6. Conversion of the valve opening into a flow of fuel gas (100 % valve opening 
corresponds to an inlet of 600 kmol/h) 

7. Flow delay (PT1 behavior with 0.75 s delay) 

8. Generation of measurement noise 

 

6.3 Soft sensor 

The process variables "EthyleneThroughput" (throughput of ethylene), 
"ConversionEthan" (conversion rate of the ethane supplied), "COT" (temperature of 
the material mixture at the coil outlet) and "TMT" (jacket temperature of the tube 
bundle) are necessary for multi-variable control. In a real system, only the initial 
temperature of the tube bundle can be measured. All other process variables are 
estimated by the soft sensor. This soft sensor is not part of the Unit Template and 
therefore the values estimated by the soft sensor are also calculated in the 
simulation and provided for the display Control Modules. 

For the simulation of the soft sensor, a matrix of linear dynamic transfer functions is 
used as a model. The process model is a 4x9 multi-variable system in which the 
influence of each input variable on each output variable is simulated by a separate 
partial transfer function. The model describes the temporal behavior of process 
deviations from the operating point. The process simulation for coking the pipes 
runs in fast motion, i.e. the period of one month in real time is simulated in 
approximately six minutes. 

The operating points, amplifications and delay times can be parameterized for each 
process variable. The partial transfer functions are implemented with PT1 behavior. 
Each partial transfer function receives the respective difference between the 
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predefined operating point and the current value of the input variables and 
calculates the output corresponding to its transfer functions. At the end, the 
associated operating point is added for each process output variable. Furthermore, 
noise can be added to the output signal. 

The following figure shows the realization of the soft sensor with the corresponding 
partial transfer functions.  

1

2

3

4

5

6

7

8

9

10

11

 

1. Calculating the operating points 

2. Conversion rate of ethane 

3. Ethylene throughput 

4. Temperature at the output of the coil 

5. Temperature of the tube metal 

6. Concentration of methane to propylene 

7. Concentration of propylene to ethylene 

8. Amount of produced ethylene 

9. Pressure difference between the furnace inlet and the furnace outlet 

10. Increase in deposits on the pipes 

11. Thickness of deposits on the pipes 
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7 Useful information 

7.1 P&I diagram 

The following figure shows the individual components of the steam cracker in the 
piping and instrumentation diagram. 
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7.2 Project structure 

7.2.1 CFC chart naming convention 

A uniform naming convention was used to designate the Control Modules. The 
function is named according to the EN 62424 European Standard. The following 
figure shows how a Control Module designation is put together: 

 

TIC_FuelGas

Function

T = Temperature (first letter)

I = Indicator (next letter)

C = Control (next letter)

Naming

 

 

The following table contains all letters used in the application and their meaning: 

First letter Meaning 

F Flow 

L Level 

M Moisture 

N Motor 

P Pressure 

Q Quality, Concentration 

S Speed (velocity, rotational speed, frequency) 

T Temperature 

W Weight 

X Freely selectable first letter 

Y Control valve 

 

Next letter Meaning 

C Control 

F Fraction 

I Indication 

S Binary control function or switching function (not 

not safety-relevant) ("Switching") 

T Transmitter (analog value processing) 

H High 

L Low 
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7.2.2 Plant view 

The "Steam Cracker" Unit Template is implemented in two hierarchy levels from a 
plant view. 

In the AS project the first hierarchy level is empty and in the subordinate hierarchy 
level there is a hierarchy folder with the necessary CFCs for each Equipment 
Module (functional unit) of the steam cracker. The simulation of the steam cracker 
is realized with PLCSIM and SIMIT and can be removed for use on a real plant. 

The first hierarchy level of the OS project contains the detailed process 
picture"Cracker.pdl" of the steam cracker.  

The structure of the multi-project is shown in the following two figures. 

Ethylene OS - Project

Cracker

PDL
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Ethylene AS - Project

AGITATION

CFC

FIC_Hydro-

carbon

CFC

FFIC_Dilution-

Steam

CFC

YC_Dilution-

Steam

CFC

YC_Hydro-

carbon

Heating

CFC

FIC_FuelGas

CFC

FIC_Air

CFC

GARC

CFC

QI_O2-

Concentration
CFC

YC_FuelGas

CFC

YC_Air

MPC

CFC

QI_YieldC2H4

CFC

XC_Product

CFC

TI_COT

CFC

TI_TMT

CFC

FI_Ethylen-

Throughput

CFC

QI_Conversion-

Ethan

KPI

CFC

QI_CokingRate

CFC

QI_CokeLevel

CFC

QI_SeverityMP

CFC

QI_SeverityPE

CFC

PI_Pressure-

Drop

SoftSensor

CFC

PI_COP

CFC

PI_CIP

CFC

QI_FG_H2

CFC

QI_HC_C3H8

CFC

TI_CIT

CFC

TI_Air

CFC

TI_FuelGas

CFC

TI_Hydrocarbon

Simulation

CFC

SIMIT_PLCSIM

CFC

Process

CFC

Softsensor

SFC

StartUp
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7.3 Additional information 

7.3.1 Additional disturbance variables 

In the control concept, additional measurable disturbance variables can be 
considered in order to increase the robustness of the process against changing 
process conditions. Reasonable disturbance variables are, for example, the 
composition of the educts or the calorific value of the fuel gas. 

The Control Modules "QI_FG_H2" and "QI_HC_C3H8" visualize the proportion of 
propane (C3H8) in the educt and the proportion of hydrogen (H2) in the burner gas 
and are indicators for a changed educt composition or other calorific value. If these 
process variables are available in a real plant, they can be used for MPC 
feedforward control. 

 

7.3.2 Control concept with a 1x1 MPC 

As an alternative to the presented 4x3 control concept of the MPC, the control of 
the steam cracker can be performed with a 1x1 MPC and additional feedforward 
control. The 1x1 control concept enables the plant operator to adjust the amount of 
educt as well as the ratio between educt and water vapor. Instead of the control 
value for the burner load, the setpoint output temperature of the tube bundle (COT 
= Coil Outlet Temperature) of a subordinate temperature controller can also be 
used. 

Due to the reduced number of degrees of freedom, only one controlled variable 
can be regulated; in this example, the ethane conversion rate is regulated. 

MPC 1x1

MV1CV1

DV1

DV2

DV3

Setpoint COTEthane turnover rate

Composition of the 

starting material

Calorific value of 

the burner gas

Educt flow rate

 

 

7.3.3 Pass Balancing 

The aim of the so-called "Pass Balancing" is, to keep for all passes (coils), which 
are heated by a burner cell, the same COT despite varying degrees of coking. The 
requirement for this is that each coil has its own flow controller with control valve. 
The total flow rate of the reactant is the sum of all coils and is controlled in the main 
supply line by a separate flow controller. 
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TI

Pass2

TI

Pass3

TI

Pass1

TI

Pass4

YC

Pass1

FIC

Pass1

YC

Pass2

FIC

Pass2

YC

Pass3

FIC

Pass3

YC

Pass4

FIC

Pass4

TotalFlow

FIC

Flow: 400

Ratio: 1.0

Flow: 100

Temperature: 660

Temperature: 687

Temperature: 655

Temperature: 678

Ratio: 1.0

Flow: 100

Ratio: 1.0

Flow: 100

Ratio: 1.0

Flow: 100

Weighed average of output 

temperature: 670

Without Pass Balancing

 

Pass Balancing calculates a weighted COT average of all coils, using the 
respective flow rate as the weighting factor. The deviation of the individual COT 
values from this mean value are the setpoints for the controllers. The output 
temperatures of the tube bundle are controlled by the flow ratio factors for the 
individual coils. 

TI

Pass2

TI

Pass3

TI

Pass1

TI

Pass4

YC

Pass1

FIC

Pass1

YC

Pass2

FIC

Pass2

YC

Pass3

FIC

Pass3

YC

Pass4

FIC

Pass4

TotalFlow

FIC

Flow: 400

Ratio: 1.05

Flow: 105.0

Temperature: 675

Temperature: 675

Temperature: 675

Temperature: 675

Ratio: 0.975

Flow: 97.5

Ratio: 0.955

Flow: 95.5

Ratio: 1.02

Flow: 102.0

Weighed average of output 

temperature: 675

With Pass Balancing

 

The "Pass Balancing" concept can be combined with the previous superimposed 
MPC concept for the total cracker, if the average COT is influenced by the total 
product flow as before. An additional controlled variable and manipulated variable 
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is required for each passport. In principle, the Pass Balancing can be solved with 
SISO controllers, an MPC is also possible as shown in the following figure as an 
example for 4 passes. 

MPC 4x4

MV1CV1

CV2

CV3

CV4

Ratio Flow 

Pass 1
Delta COT Pass 1

Delta COT Pass 2

Delta COT Pass 3

MV2

MV3

MV4Delta COT Pass 4

Ratio Flow 

Pass 2

Ratio Flow 

Pass 3

Ratio Flow 

Pass 4
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8 Appendix 

8.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain  
 

Service offer 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
https://www.siemens.com/industry/supportrequest
https://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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8.2 Links and literature 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to this entry page of this application example  

https://support.industry.siemens.com/cs/ww/en/view/109769355 

\3\ SIMATIC PCS 7 Overview (link collection to FAQ, manuals, compendium, forum, 
application examples and multimedia) 

https://support.industry.siemens.com/cs/ww/en/view/63481413 

\4\ Equipment Modules for SIMATIC PCS 7 using the example of the Chemical 
Industry 

https://support.industry.siemens.com/cs/ww/en/view/53843373 

\5\ PCS 7 Unit Template "Stirred Tank Reactor" using the example of the Chemical 
Industry 

https://support.industry.siemens.com/cs/ww/en/view/60546560 

\6\ PCS 7 Unit Template "Fermenter" using the example of the Chemical Industry 

https://support.industry.siemens.com/cs/ww/en/view/68098270 

\7\ PCS 7 Unit Template "Distillation Column" using the example of the Chemical 
Industry 

https://support.industry.siemens.com/cs/ww/en/view/48418663 

\8\ PCS 7 Unit Template "Stirred tank reactor with Kalman filter" using the example of 
the Chemical Industry 

https://support.industry.siemens.com/cs/ww/en/view/109756215 

\9\ PCS 7 Unit Template – Gas Fired Steam Boiler 

https://support.industry.siemens.com/cs/ww/en/view/109755201 

\10\ Simulation with SIMIT and SIMATIC PCS 7 using a practical example 

https://support.industry.siemens.com/cs/ww/en/view/77362399 

\11\ Simulation of a PCS 7 stirred tank reactor with SIMIT Simulation Framework 

https://support.industry.siemens.com/cs/ww/en/view/93148023 

\12\ Evolution of a Digital Twin using the example of an ethylene plant 

http://ojs.di-verlag.de/index.php/atp_edition/article/view/2427 

\13\ Control and optimization of steam cracker units. 

Pfeiffer, B.-M.; Leingang, C; Pohmer, F.; Labisch, D; Grieb, H.; Lorenz O.:  

Model-based monitoring Proceedings AUTOMATION 2019, Baden-Baden, 
02.07.2019 

 

8.3 Change documentation 

Version Date Modifications 

V1.0 10/2019 First version 

   

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/109769355
https://support.industry.siemens.com/cs/ww/en/view/63481413
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/60546560
https://support.industry.siemens.com/cs/ww/en/view/68098270
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/view/109756215
https://support.industry.siemens.com/cs/ww/en/view/109755201
https://support.industry.siemens.com/cs/ww/en/view/77362399
https://support.industry.siemens.com/cs/ww/en/view/93148023
http://ojs.di-verlag.de/index.php/atp_edition/article/view/2427
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